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ActiveX Controls in the Office 97 Developer Edition

Microsoft Corporation

April 1998

This article discusses the Microsoft® Office Developer Edition (ODE) ActiveX® controls. A basic description of each control is provided, followed by a step-by-step procedure and Visual Basic® for Applications code example that illustrate how to use that control in an Office application.

The ODE includes 13 ActiveX controls. You can use these controls to expand the functionality of any Microsoft Office application that supports them. The controls included in the ODE provide a broad variety of features: 

· The Slider, RichTextBox, and CommonDialog controls offer an easy way to add basic and very useful user-interface elements to Office applications. 

· The StatusBar, ToolBar, and TabStrip controls offer a simple means of implementing specific Microsoft Windows 95 user-interface elements. 

· The Winsock and Internet Transfer controls provide data connectivity.

· The TreeView, ImageList, and ListView controls are designed to be combined with other controls so that developers can easily display complex mixtures of graphics and alphanumeric data. 

The ODE includes a sample application that demonstrates the use of ActiveX controls in Microsoft Access. You'll find this sample application on the ODE compact disc, at the following location: [Drive name]:\Msds\Odesmpl\Olecont\Actctrls.mdb.

For more information about these controls, see Help in the ODE, or see the Component Tools Guide for Visual Basic version 5.0. The master Help file in the ODE is named Msorun.hlp; it's located in the Odetools folder on the CD. For information about updated versions of these controls, see the Web article at the following address:

www.microsoft.comhttp://msdn.microsoft.com/officedev/prodinfo/odeandvb.htm
ActiveX controls may behave differently in different host applications. For more information, see the Knowledge Base article "Limitations of ActiveX Control Support in Office Documents" (Q168392).

The ODE ActiveX Controls

CommonDialog Control
ImageList Control
InternetTransfer Control
ListView Control
ProgressBar Control
RichTextBox Control
Slider Control
StatusBar Control
TabStrip Control
Toolbar Control
TreeView Control
UpDown Control
Winsock Control
CommonDialog Control

You may have noticed that when you perform common Windows® operations such as opening, printing, and saving files, the dialog boxes for these actions look the same, regardless of the application you're using. This is because they are, in fact, the very same dialog boxes. These commonly used dialog boxes are available for all Windows developers to use in their applications, by means of a particular ActiveX control — the CommonDialog control. Using this control is an easy way to ensure that your users experience the standard Windows look and feel in your applications.

The CommonDialog control provides a standard set of dialog boxes for such frequent operations as opening and saving files, setting printing options, and selecting colors and fonts. You can also use this control to display Help in a given Office application by running the Windows Help engine.

The CommonDialog control provides an interface between Visual Basic for Applications and the procedures in the Windows dynamic-link library Commdlg.dll. To create a dialog box by using this control, you must have Commdlg.dll in your System folder in Windows 95 or in your System32 folder in Windows NT.

You use the CommonDialog control in an Office application by adding it to a form and then setting its properties. Which dialog box the control displays is determined by the methods you set for the control. When the appropriate method is invoked at run time, either a dialog box is displayed or the Help engine is run.

The following table provides a list of the methods you can use with the CommonDialog control as well as the dialog boxes that these methods display.

	Method
	Does this

	ShowOpen
	Displays the Show Open dialog box.

	ShowSave
	Displays the Show Save As dialog box.

	ShowColor
	Displays the Show Color dialog box.

	ShowFont
	Displays the Show Font dialog box.

	ShowPrinter
	Displays the Show Print or Print Options dialog box.

	ShowHelp
	Invokes the Windows Help engine.


The CommonDialog control itself isn't visible at run time. At design time, it's displayed as an icon on a form. You cannot resize this icon.

Note that there's no way to specify where on the screen a given dialog box is displayed.

Using the CommonDialog Control

This section provides two procedures that demonstrate the use of the CommonDialog control in an Office application. The first procedure, which shows you how to add a CommonDialog control to a user form, is essentially the same  process you use for all of the other ActiveX controls included in the ODE. Subsequent sections in this article will refer you back to this procedure.

The second procedure shows you how to program a CommonDialog control so that the Open dialog box is automatically displayed within the Visual Basic Editor when you click the user form containing the control.

Add a CommonDialog control to a user form 

1. In an Office application, open the Visual Basic Editor.

2. On the Insert menu in the Visual Basic Editor, click UserForm.

3. On the Tools menu, click Additional Controls.

4. In the Available Controls box, click Microsoft Common Dialog Control, version 5.0, and then click OK.

5. Add a CommonDialog control to the user form by dragging the control from the Toolbox onto the form. 

Use code to display the Open dialog box 

1. Right-click the control you just added to the user form, and then click Properties.

2. In the Properties window, set the control's Name property to cdlODE.

3. In the Code window, enter the following procedure: 

4. Option Explicit

5. Private Sub UserForm_Click()

6.    cdlODE.Showopen

7. End Sub

8. Click the Run button on the Visual Basic Editor toolbar.

9. Click anywhere on the user form to run the Click event and display the Open dialog box. 
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ImageList Control

You can use the ImageList control in conjunction with other common Windows controls—specifically, the ListView, TreeView, TabStrip, and Toolbar controls. You use the ImageList control to store a collection of images that can then be used by an associated control; for example, it can store the images that appear on a Toolbar control's buttons.

You can also use the ImageList control with controls that assign a Picture object to a Picture property, such as the Image and CommandButton controls.

Using the ImageList control as a single repository saves you development time, because you can write code that refers to a single, consistent catalog of images. Instead of writing code that loads bitmaps or icons (using the LoadPicture function), you can populate the ImageList control once, assign key values to it if you want, and then write code that uses the Key property or the Index property to refer to images.

This control uses bitmap (.bmp) or icon (.ico) files in a collection of ListImage objects. You can add and remove images either at design time or at run time. The ListImage object has the standard collection object properties: Key, Index, and Count. It also has standard methods, such as the Add, Remove, and Clear methods.

Possible Uses

· Use the ImageList control to store the images that represent open folders, closed folders, and documents. You can then dynamically assign these images to the TreeView control's Node object to represent each node's different states as it expands or collapses, or to indicate whether the node represents a document or a folder.

· Use it to store images that represent common computer operations, such as opening, saving, and printing files. You can then assign these images to Button objects on a Toolbar control used by your application.

· Use it to store images for drag-and-drop operations, such as the DragIcons and MousePointer icons. 

Using the ImageList Control

In this section, you'll learn how to use the ImageList control in an Office application.

Use the ImageList control to add images
This procedure shows you how to insert an ImageList control onto a user form and then add images to that control. 

1. Perform steps 1 through 3 of the procedure "Add a CommonDialog control to a user form" earlier in this article.

2. In the Available Controls box, click Microsoft ImageList Control, version 5.0, and then click OK.

3. Add an ImageList control to the user form by dragging the control from the Toolbox onto the form. 

4. Similarly, add an Image control to the user form.

5. In the Properties window, set the Image control's Name property to imgTarget. 

If the Properties window isn't already displayed, press F4.

6. Set the Image control's PictureSizeMode property to fmPictureSizemodeZoom.

7. Set the user form's Caption property to ImageList.

8. Set the ImageList control's Name property to imlODE.

9. In the Properties window, click (Custom), and then click the Properties button (…).

10. On the Images tab, click Insert Picture.

11. Click a .bmp or .ico file, and then click Open. One source for these images is the Csample folder on the ODE compact disc ([Drive name]:\\Msds\Odesmpl\Ode\Msdnoc2\Csample).

12. Assign a unique Key property by typing a string in the Key box. Optionally, you can assign a Tag property by typing a string in the Tag box. Note that the Tag property doesn't have to be unique.

13. Click OK.

14. Repeat steps 9 through 12 to add whatever other images you want to the control.

15. In the Code window, enter the following procedure: 

16. Option Explicit

17. Private Sub UserForm_Click()

18.    ' Connects the Image control to an image stored in the ImageList control.

19.    Set imgTarget.Picture = imlODE.ListImages(1).Picture

20. End Sub

Note   The process for doing this in Microsoft Access is slightly different. You can see an example of this in the sample application mentioned in step 11 of this procedure.

21. Click Run Sub/UserForm. 
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To display the other images, change the Index value for the ListImages property.

InternetTransfer Control

The InternetTransfer control works with two widely used Internet protocols: the Hypertext Transfer Protocol (HTTP) and the File Transfer Protocol (FTP). Using the InternetTransfer control, you can connect to any Internet site that uses one of these protocols. After you've connected to a site, you can retrieve files by using either the OpenURL method or the Execute method. 

Possible Uses

· Add an FTP browser to any application.

· Create an application that automatically downloads files from a public FTP site.

· Parse a World Wide Web site for graphics references and then download only the graphics.

· Present a custom display of dynamic data retrieved from a Web page. 

Basic Operation

The functionality of the InternetTransfer control differs depending on the protocol you're using, because FTP and HTTP work differently in many respects. For example, the GetHeader method only works with HTTP (HTML documents).

There are, however, a few procedures that are common to both protocols. Basically, to use either protocol, you must first perform the following steps: 

1. Set the AccessType property to a valid server.

2. Invoke the OpenURL method with a valid URL.

3. Invoke the Execute method with a valid URL and a command appropriate to the protocol.

4. Use the GetChunk method to retrieve data from the buffer. 

Using the InternetTransfer Control

In this section, you'll learn how to use the Internet Transfer control in an Office application.

Set a reference to MSInet.ocx
To use the InternetTransfer control, you must first set a reference to the file MSInet.ocx. 

1. MSInet.ocx must be located in either your System folder or your System32 folder. If it's not there, copy it from the ODE compact disc.

2. In the Visual Basic Editor, click References on the Tools menu.

3. In the References dialog box, click Browse.

4. In the Add References dialog box, click MSInet.ocx and then click Open.

5. In the References dialog box, click OK. 

Add an InternetTransfer control to a user form
This procedure shows you how to add an InternetTransfer control to a user form, set the control's properties, add code to it, and then run the code. 

1. Perform steps 1 through 3 of the procedure "Add a CommonDialog control to a user form" earlier in this article.

2. In the Available Controls box, click Microsoft Internet Transfer Control, version 5.0, and then click OK.

3. Add an InternetTransfer control to the user form by dragging the control from the Toolbox onto the form.

4. Similarly, add a TextBox control to the user form. 

5. Set the user form's Caption property to INet.

6. Set the TextBox control's Name property to txtDisplay.

7. Set the InternetTransfer control's Name property to itcODE.

8. In the Code window, enter the following procedure: 

9. Option Explicit

10. Private Sub UserForm_Click()

11.     Dim strURL As String

12.     strURL = "http://www.microsoft.com/vbasic/"

13.     'Opens and returns the document at the specified URL

14.     txtDisplay.Text = itcODE.OpenURL(strURL)

15. End Sub

16. Click Run Sub/UserForm. 
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Note   It's often worthwhile to use this control in conjunction with the WebBrowser control; used by itself, the InternetTransfer control causes HTML to fail, whereas the WebBrowser control displays HTML correctly. The WebBrowser control is included with the Microsoft Internet Explorer. For more information, see "Using the WebBrowser Control" in Building Applications with Microsoft Access 97.

ListView Control

The ListView control displays data as ListItem objects. This control excels at representing subsets of data (such as members of a database) or discrete objects (such as document templates).

Using the ListView control, you can display data in any of four different views, or modes. How you program the control may depend on which of these views you want the user to be able to select. Each of the four views has a particular advantage over the other three. Some of these advantages are listed in the following table.

	View
	Advantage

	Icon
	Can be manipulated with the mouse, so the user can drag and drop objects and then rearrange them. 

	SmallIcon
	Allows more ListItem objects to be viewed than in Icon view. As in Icon view, the user can rearrange objects in SmallIcon view.

	List
	Presents a sorted view of ListItem objects.

	Report
	Presents a sorted view of ListItem objects, with subitems you can use to display extra information.


Possible Uses

· Display the results of a query on a specified database.

· Display all of the records in a specified database table.

· Use this control in tandem with a TreeView control to give users an expanded view of a TreeView control node. 

ListItem and ColumnHeader Objects

The ListView control contains ListItem and ColumnHeader objects. These objects define the various characteristics of items in the ListView control, providing the following: 

· A brief description of the specified item.

· Icons that may appear with the specified item; these icons are generated by an ImageList control.

· Additional pieces of text, called subitems, which are associated with a ListItem object that you can display in Report view. 

A ColumnHeader object is an item in a ListView control that contains heading text. You can add this object either at design time or at run time. At design time, you do this on the Column Headers tab in the ListView Control Properties dialog box. At run time, use the Add method to add a ColumnHeader object to the ColumnHeaders collection.

Using the ListView Control

In this section, you'll learn how to use the ListView control in an Office application. 

Add a ListView control to a user form
This procedure shows you how to insert a ListView control onto a user form, set the control's properties, add code to it, and then run the code. 

1. Perform steps 1 through 3 of the procedure "Add a CommonDialog control to a user form" earlier in this article.

2. In the Available Controls box, click Microsoft ListView Control, version 5.0, and then click OK.

3. Add a ListView control to the user form by dragging the control from the Toolbox onto the form.

4. Set the user form's Caption property to ListView.

5. Add an ImageList control to the user form. 

Note   If you don't see this control in the Toolbox, click Additional Controls on the Tools menu, click Microsoft ImageList Control, version 5.0, and then click OK.

6. Set the ImageList control's Name property to imlSupport. 

7. Set the ListView control's Name property to IsvODE.

8. This example uses the Northwind database, so you'll need to set a reference to DAO 3.5. To do this, click References on the Tools menu, and then select Microsoft DAO 3.5 Object Library in the References dialog box.

9. On the Insert menu, click Module.

10. In the Code window, enter the following procedure: 

Note   The OpenDatabase method in the Setup subprocedure refers to the default installation folder for Northwind.mdb. The location on your computer may vary.

Option Explicit

Public mdbNWind As Database

Public mItem As ListItem

Public rsProducts As Recordset

Sub SetUp()

    ' Open Northwind.

    Set mdbNWind = DBEngine.OpenDatabase("c:\program files\microsoft office\office\samples\northwind.mdb")

    ' Load the UserForm.

    Load usfODE

    ' Add ColumnHeaders.

    usfODE.lsvODE.ColumnHeaders.Add , , "Product Name", usfODE.lsvODE.Width / 2, lvwColumnLeft

    usfODE.lsvODE.ColumnHeaders.Add , , "Units in Stock", usfODE.lsvODE.Width / 4, lvwColumnLeft

    usfODE.lsvODE.ColumnHeaders.Add , , "Price", usfODE.lsvODE.Width / 4, lvwColumnLeft

    ' Set the view type to Report.

    usfODE.lsvODE.View = lvwReport

    ' Connects the ImageList and the ListView controls.

    usfODE.lsvODE.SmallIcons = usfODE.imlSupport

    Call GetProducts

End Sub

Sub GetProducts()

    usfODE.lsvODE.ListItems.Clear

    ' Open the recordset.

    Set rsProducts = _

    mdbNWind.OpenRecordset("SELECT Products.UnitPrice, Products.ProductName,Products.UnitsInStock FROM Products;")

    ' Read four Northwind records into the ListView control.

    Dim intCounter As Integer

    For intCounter = 1 To 4

        ' Add a ListItem.

        Set mItem = usfODE.lsvODE.ListItems.Add()

        mItem.Text = rsProducts!PRODUCTNAME

        mItem.SubItems(1) = rsProducts!UNITPRICE

        mItem.SubItems(2) = rsProducts!UNITSINSTOCK

        ' Determine which icon to associate with the ListItem.

        mItem.SmallIcon = 1

        ' Get the next record.

        rsProducts.MoveNext

    Next intCounter

    ' Display the UserForm.

    usfODE.Show

End Sub

11. Click anywhere in the procedure declaration for the SetUp subprocedure, and then click Run Sub/UserForm. 
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ProgressBar Control

Use the ProgressBar control for operations in Office applications that you know will take more than a few seconds to complete. By using the ProgressBar control, you can see a graphical representation of the progress of any given operation. This control consists of a frame, or progress bar, that gets filled at a rate proportional to the operation's percentage-of-completion status.

Use the Value property to determine how much of the operation has been completed. You use the Min and Max properties to set the control's limits. You must define how long the process will take by using a known end point and setting it as the control's Max property.

Possible Uses

· Inform the user of progress status during a file transfer over a network.

· Indicate progress status for an operation that takes more than a few seconds.

· Inform the user of progress status during a complex algorithm calculation. 

Making It Easier

Use the Value property with the Min and Max properties to show progress

While the progress bar is displaying the progress of an operation, the Value property is continually incremented until a maximum—which you define with the Max property—is reached. Thus, the number of increments, or chunks, displayed by the progress bar is always a ratio of the Value property to the Min and Max properties. For example, if the Min property is set to 1 and the Max property is set to 100, a Value property of 50 will cause the progress bar to display 50 percent of the chunks.

Set the Max property to a known limit

To program the ProgressBar control, you must first set a limit that the Value property won't exceed. For example, if a user is downloading a file and the application he or she is using can determine the size of the file (in kilobytes), you can set the Max property to that number. As the file is downloaded, the application must also have some way of determining how many kilobytes have been downloaded; set the Value property to that number.

Sometimes the Max property can't be determined in advance. In these cases, instead of using the ProgressBar control, you may want to use the Visual Basic Animation control to continuously show an animation sequence until the Stop method is invoked in a Terminate event.

Hide the progress bar by using the Visible property

Generally, you won't want the progress bar to appear until an operation has begun, and you'll probably want it to disappear as soon as the operation ends. Set the Visible property to True to have the progress bar displayed at the start of an operation, and reset this property to False to have the bar disappear when the operation ends.

Using the ProgressBar Control

In this section, you'll learn how to use the ProgressBar control in an Office application. 

1. Perform steps 1 through 3 of the procedure "Add a CommonDialog control to a user form" earlier in this article.

2. In the Available Controls box, click Microsoft ProgressBar Control, version 5.0, and then click OK.

3. Add a ProgressBar control to the user form by dragging the control from the Toolbox onto the form.

4. Similarly, add a CommandButton control to the user form.

5. Set the ProgressBar control's Name property to prgODE.

6. Set the CommandButton control's Name property to cmdStart, and then set its Caption property to Start.

7. Set the user form's Caption property to ProgressBar.

8. In the Code window, enter the following procedure: 

9. Option Explicit

10. Private Sub cmdStart_Click()

11.     Dim intCounter As Integer

12.     ' Initialize the array.

13.     Dim arrWorkArea(5000) As String

14.     prgODE.Visible = False

15.     ' Set the Min and Max properties.

16.     ' To the upper and lower bounds of the array.

17.     prgODE.Min = LBound(arrWorkArea)

18.     prgODE.Max = UBound(arrWorkArea)

19.     prgODE.Visible = True

20.     ' Initialize the Value property.

21.     prgODE.Value = prgODE.Min

22.     ' Loop through the array.

23.     For Counter = LBound(arrWorkArea) To UBound(arrWorkArea)

24.         ' Set initial values for each item in the array.

25.         arrWorkArea(Counter) = "Initial value" & Counter

26.         ' Increment the Value property.

27.         prgODE.Value = Counter

28.     Next Counter

29.     ' We're done, hide the ProgressBar.

30.     prgODE.Visible = False

31.     prgODE.Value = prgODE.Min

End Sub
9. Click Run Sub/UserForm. 

You may want to tweak the value in the array declaration to increase or decrease the progress bar's display time.
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RichTextBox Control

You can use the RichTextBox control to enter and edit text. This control provides more advanced formatting features than does the conventional TextBox control. In addition, the RichTextBox control has a number of properties you can use to apply formatting to any portion of text within the control. Using these properties, you can make text bold or italic (or both), change its color, and create superscripts and subscripts. You can also adjust paragraph formatting by setting left and right indents and hanging indents.

To change the formatting of text, you must first select the text you want to make these changes to, because you can assign character and paragraph formatting only to text that's selected.

Possible Uses

· Use as a "bottomless" text box so that a given Office application can read extremely large text files.

· Implement a full-featured text-editing application in any Office application. 

Features

The RichTextBox control has a number of robust features you can use to considerably enhance the functionality within your customized Office applications. Using this control, you can: 

· Open and save files in both the RTF and ASCII text formats. You can use the LoadFile and SaveFile methods of the RichTextBox control to read and write files directly; you can also use properties of the control, such as SelRTF and TextRTF, in conjunction with Visual Basic file input/output statements.

· Load the contents of an .rtf file into the RichTextBox control simply by dragging the file (from the Windows Explorer, for example) or a highlighted portion of a file created in another application (such as Microsoft Word) and then dropping the contents directly onto the control.

· Set the FileName property to load the contents of an .rtf or .txt file into the control.

· Print all or part of the text in a RichTextBox control by using the SelPrint method.

· Programmatically add embedded objects such as bitmaps and icons to the control at run time by using the OLEObject collection's Add method. At both design time and run time, you can drag and drop any embedded objects—including documents such as Microsoft Excel spreadsheets and Word documents—into the control.

· Employ almost all of the properties, events, and methods used with the standard TextBox control, such as the MaxLength, MultiLine, ScrollBars, SelLength, SelStart, and SelText properties. You can easily adapt applications that already use TextBox controls to make use of RichTextBox controls. Note that a RichTextBox control isn't restricted by the 64-character limit that applies to the conventional TextBox control. 

Using the RichTextBox Control

In this section, you'll learn how to use the RichTextBox control in an Office application.

Add a RichTextBox control to a user form
This procedure shows you how to insert a RichTextBox control onto a user form, set the control's properties, add code to it, and then run the code. 

1. Perform steps 1 through 3 of the procedure "Add a CommonDialog control to a user form" earlier in this article.

2. In the Available Controls box, click Microsoft RichTextBox Control, version 5.0, and then click OK.

3. Add a RichTextBox control to the user form by dragging the control from the Toolbox onto the form.

4. Similarly, add a ComboBox control to the user form.

5. Set the RichTextBox control's Name property to rtfODE.

6. Set the ComboBox control's Name property to cmdSetColor.

7. Set the user form's Caption property to RichTextBox.

8. In the Code window, enter the following procedure: 

9. Option Explicit

10. Private Sub cmbSetColor_Click()

11.     With rtfODE

12.         Select Case cmbSetColor.ListIndex

13.             Case 0

14.                 .SelColor = vbBlack

15.             Case 1

16.                 .SelColor = vbBlue

17.             Case 2

18.                 .SelColor = vbRed

19.         End Select

20.     End With

21. End Sub

22. Private Sub UserForm_Initialize()

23.     With cmbSetColor

24.         .AddItem "Black"

25.         .AddItem "Blue"

26.         .AddItem "Red"

27.         .ListIndex = 1

28.     End With

29. End Sub

30. Click Run Sub/UserForm.

31. Type whatever text you want in the RichTextBox control, select the text, and then use the ComboBox control to select a font color. 
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Slider Control

The Slider control makes it possible for the user to graphically select numeric values. A Slider control consists of a scale, which you define by using the Min and Max properties, and a "thumb," which the user can manipulate with either the mouse or the arrow keys. You can dynamically reset the Min and Max properties at run time to reflect a new range of values. The Value property returns the current position of the thumb.

Possible Uses

· Set the value of a point on a graph.

· Select a range of numbers to be passed into an array, using events such as MouseDown and MouseUp.

· Resize a form, field, or other graphic object. 

TickStyle and TickFrequency Properties

The Slider control consists of two parts: the thumb and the tick marks.

The appearance of the control at any given moment depends on the TickStyle property. In brief, the tick marks can appear along the bottom of the control (the default position) as shown in the preceding illustration, along the top, along both the top and the bottom, or not at all.

In addition to adjusting the placement of the tick marks, you can also program how many tick marks appear on the control by setting the TickFrequency property. Use this property in conjunction with the Min and Max properties to specify how many tick marks will appear on the control. For example, if the Min property is set to 0, Max is set to 100, and TickFrequency is set to 5, there will be one tick mark for every five increments, for a total of 21 tick marks. If you reset the Min and Max properties at run time and you want to know how many tick marks there are, you can use the GetNumTicks method, which returns the current number of tick marks on the control.

Set the Min and Max Properties at Design Time or Run Time

You use the Min and Max properties to specify the upper and lower limits of a Slider control; you can set these properties either at design time or at run time. At design time, set values for Min and Max in the Properties window.

At run time, you can reset the Min and Max values to accommodate different ranges. For example, if you are using a Slider control to change values in a database, you can use this same control and bind it to different fields, depending on what table the user is editing.

SmallChange and LargeChange Properties

You use the SmallChange and LargeChange properties to set the size of increments by which the Slider control will increase or decrease when the user clicks it. The SmallChange property specifies how many ticks the thumb will move when the user presses the LEFT ARROW or RIGHT ARROW key. The LargeChange property specifies how many ticks the thumb will move when the user clicks the control or when the user presses the PAGE UP or PAGE DOWN key.

Using the Slider Control

In this section, you'll learn how to use the Slider control in an Office application.

Add a Slider control to a user form
This procedure shows you how to insert a Slider control onto a user form, set the control's properties, add code to it, and then run the code. 

1. Perform steps 1 through 3 of the procedure "Add a CommonDialog control to a user form" earlier in this article.

2. In the Available Controls box, click Microsoft Slider Control, version 5.0, and then click OK.

3. Add a Slider control to the user form by dragging the control from the Toolbox onto the form.

4. Similarly, add an Image control to the user form.

5. Set the Slider control's Name property to sldODE.

6. Set the Image control's Name property to imgTarget.

7. Set the user form's Caption property to Slider.

8. In the Code window, enter the following procedure: 

9. Option Explicit

10. Public lngHeight As Long

11. Public lngWidth As Long

12. Private Sub sldODE_Scroll()

13.     imgTarget.Height = sldODE.Value * lngHeight

14.     imgTarget.Width = sldODE.Value * lngWidth

15. End Sub

16. Private Sub UserForm_Initialize()

17.     lngHeight = imgTarget.Height / 100

18.     lngWidth = imgTarget.Width / 100

19.     sldODE.Max = 100

20. End Sub

21. Click Run Sub/UserForm.

22. Manipulate the thumb on the Slider control to shrink or expand the Image control. 
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StatusBar Control

The StatusBar control provides a horizontal bar (a status bar), usually across the bottom of a parent form, in which an application displays various kinds of status data. You can divide the status bar into a maximum of 16 Panel objects, which are contained in the Panels collection.

These Panel objects that make up the status bar can contain text or pictures, or both. To control the appearance of individual panels, you use the Width, Alignment (for a panel's contents), and Bevel properties. Additionally, you can use one of seven values of the Style property to automatically display common data such as date, time, and the status of specific keys on the keyboard.

At design time, you can create panels and customize their appearance by setting values on the Panel tab on the Properties page for the StatusBar control. At run time, you can reconfigure the Panel objects to reflect different functions, depending on the state of the application. For detailed information about the properties, events, and methods of Panel objects, see the "Panel Object" and "Panels Collection" topics in Visual Basic Help.

Possible Uses

· Inform the user of a database table's metrics (such as number of records) and the current position of the table in the database.

· Provide the user with the current text and font status for the specified RichTextBox control.

· Provide the user with the current status of specific keys, such as CAPS LOCK or NUM LOCK. 

The StatusBar control, together with the Toolbar control and others, gives you the tools to create an interface that's economical and yet rich in information for the user.

Use the Set Statement with the Add Method to Create Panels at Run Time

To add Panel objects at run time, use the Set statement with the Add method. First declare an object variable of the Panel type, and then set the object variable to a Panel object created by using the Add method, as in the following code:

' The StatusBar control is named "sbrDB."

Dim pnlX As Panel

Set pnlX = sbrDB.Panels.Add()

After you've created a Panel object and set the object variable to reference the new object, you can set the panel's various properties as follows:

pnlX.Text = Text1.Text 

pnlX.Picture = LoadPicture("mapnet.bmp")

pnlX.Key = "drive"

If you want the StatusBar control to respond in a certain way whenever the user clicks a particular panel, be sure to set the panel's Key property. Because the Key property must be unique, you can use it to identify panels on a status bar.

Using the Select Case Statement in the PanelClick Event to Determine the Clicked Panel

To program a StatusBar control to respond whenever the user clicks a specific panel, use the Select Case statement in the PanelClick event. This event contains an argument (the panel argument) that passes a reference to the clicked Panel object. Using this reference, you can determine the Key property of the clicked panel and then proceed with your program accordingly, as shown in the following code:

Private Sub sbrDB_PanelClick(ByVal Panel As Panel)

   Select Case Panel.Key

   Case "drive"

      Panel.Text = Text1.Text

   Case "openDB"

      Panel.Text = rsOpenDB.Name

   Case Else

   ' Handle other cases.

   End Select

End Sub

Using the Bevel, AutoSize, and Alignment Properties to Program Appearance of Panels

With the Bevel, AutoSize, and Alignment properties, you can precisely control the appearance of each Panel object. Use the Bevel property to specify whether the panel will have an inset bevel (the default), a raised bevel, or no bevel at all.

The following table lists the possible settings for the Bevel property.

	Constant
	Value
	Description

	SbrNoBevel 
	0
	The panel has no bevel, and text looks as if it's displayed right on the status bar.

	SbrInset
	1
	The panel appears to be sunk into the status bar.

	SbrRaised
	2
	The panel appears to be raised above the plane of the status bar.


Use the AutoSize property to specify how a Panel object will size itself when the user resizes the parent container (either a form or a container control).

This table lists the possible settings for the AutoSize property.

	Constant
	Value
	Description

	sbrNoAutoSize
	0
	No autosizing occurs. The panel is always exactly the width you've specified by using the Width property.

	sbrSpring
	1
	When the parent form is resized and there's extra space available, all panels with this setting grow proportionally to fill the available space. However, the panels are never narrower than the minimum width you've specified with the MinWidth property.

	sbrContents
	2
	The panel is resized to accommodate its contents. 


Use the Alignment property to specify how the text in a panel will be aligned relative to the panel itself and relative to any image in the panel.

This table lists the possible settings for the Alignment property.

	Constant
	Value
	Description

	sbrLeft
	0
	Text appears left justified and to the right of any bitmap.

	sbrCenter
	1
	Text appears centered and to right of any bitmap.

	sbrRight
	2
	Text appears right justified but to the left of any bitmap.


Using the Style and SimpleText Properties

The StatusBar control features a secondary mode in which multiple panels are replaced by a single panel that spans the width of the control. This single panel has just one property—the SimpleText property—which specifies the text to be displayed on the panel. To display this single panel, set the Style property of the StatusBar object to sbrSimple (1).

One reason for switching to the Simple style and displaying a single panel is to notify the user that a lengthy transaction is in progress. For example, if you're performing a database operation, you can use the Simple style to notify the user of the current status of the transaction, as the following code illustrates:

Private Sub GetRecords(State)

   ' The query finds all records which match

   ' the parameter State. While the query 

   ' is creating the recordset, show the

   ' SimpleText on the StatusBar control.

   sbrDB.SimpleText = "Getting records …"

   sbrDB.Style = sbrSimple ' Simple style.

   sbrDB.Refresh    ' You must refresh to see the 

                  ' Simple text.

   Set rsNames = mDbBiblio.OpenRecordset _

   ("select * from Names Where State= " & _

   State)

End Sub

Using the StatusBar Control

This section provides two procedures that demonstrate the use of the StatusBar control in an Office application. The first procedure, which shows you how to add a StatusBar control to a user form, is essentially the same process you use for all of the other ActiveX controls included in the ODE. Subsequent sections in this article will refer you back to this procedure.

Note that all of these ActiveX controls are included in both the ODE and Visual Basic 5.0.

Add a StatusBar control to a user form 

1. In an Office application, open the Visual Basic Editor.

2. On the Insert menu, click UserForm.

3. On the Tools menu, click Additional Controls.

4. In the Available Controls box, select Microsoft StatusBar Control, version 5.0, and then click OK.

5. Add a StatusBar control to the user form by dragging the control from the Toolbox onto the form. 

Add more controls to the form 

1. Drag a CommandButton control and a TextBox control from the Toolbox onto the user form.

2. Position the controls so that your form resembles the one shown in the illustration following the next procedure.

3. Set Name and Caption properties for your form and the controls you've added to it, using the values listed in the following table. 

	Object
	Property
	Setting

	User form
	Caption
	StatusBar

	Status bar
	Name
	sbrODE

	Text box
	Name
	txtProduct

	Command button
	Name
	cmdNextRecordl

	Command button 
	Caption
	Next Record


Using Code to Display the StatusBar Control

In this section, you'll use the Northwind sample database (included in Office 97) and add a Visual Basic procedure to display the status bar you created in the preceding exercise. To do this, you'll need to set a reference to DAO 3.5.

Display the status bar programmatically 

1. In the Visual Basic Editor, click References on the Tools menu.

2. In the References dialog box, select Microsoft DAO 3.5 Object Library, and then click OK.

3. In the Code window, enter the following code and procedures: 

4. Public mdbNWind As Database

5. Public rsProducts As Recordset

6. Private Sub UserForm_Initialize()

7.     Dim pnlX As Panel

8.     Dim intCounter As Integer

9.     ' Add two panels to the one already present.

10.     For intCounter = 1 To 2

11.         Set pnlX = sbrODE.Panels.Add()

12.     Next intCounter

13.     Call LoadStatusBar

14. End Sub

15. Sub LoadStatusBar()

16.     ' Open the Northwind database.

17.     Set mdbNWind = DBEngine. _

18.     OpenDatabase("c:\program files\devstudio\vb\nwind.mdb")

19.     ' Open a recordset containing three fields from the Products table.

20.     Set rsProducts = _

21.     mdbNWind.OpenRecordset _

22.     ("SELECT Products.UnitPrice, Products.ProductName,Products.UnitsInStock FROM Products;")

23. End Sub

24. Private Sub cmdNextRecord_Click()

25.     ' Get the next record.

26.     rsProducts.MoveNext

27.     ' Add current product name to the text box.

28.     txtProduct.Text = rsProducts!PRODUCTNAME

29.     ' Add status text to the three panels.

30.     sbrODE.Panels(1).Text = "Count " & rsProducts.RecordCount

31.     sbrODE.Panels(2).Text = "Absolute = " & rsProducts.AbsolutePosition

32.     sbrODE.Panels(3).Text = "Percent = " & rsProducts.PercentPosition

End Sub
4. On the View menu, click Object to display the user form.

5. Click Run Sub/UserForm or press F5 to run the procedure. 
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TabStrip Control

The TabStrip control is like the dividers in a notebook or the labels on a group of file folders. By using this control, you can define multiple pages for the same area of a window or dialog box in your application.

Possible Uses

· Create a tabbed dialog box in which the user can set various text attributes for a RichTextBox control.

· Create a tabbed dialog box in which the user can set preferences for an application, such as display style (SDI or MDI), fonts, default folder, and number of items to display in the MRU list. 

The Tabs Collection

The TabStrip control consists of one or more Tab objects, which belong to the Tabs collection. At either design time or run time, you can alter the Tab object's appearance by setting properties. You can also add and remove tabs by using the Properties page for the TabStrip control at design time, or you can add and remove tabs at run time by using methods of the Tabs collection.

You use the Style property to specify whether the TabStrip control looks like "push" buttons (tabButtons) or notebook tabs (tabTabs). If you add a TabStrip control to a user form at design time, the control has one notebook-style tab. If you've set the control's Style property to tabTabs, there will be a border around the control's internal area. If you've set its Style property to tabButtons, that internal area will still exist, but there won't be a border around it.

To set the overall size of the TabStrip control, drag its sizing handles or set its Top, Left, Height, and Width properties—or use a combination of these two techniques. Based on the control's overall size at run time, Visual Basic for Applications automatically determines the size and position of the internal area and returns the client-coordinate properties: ClientLeft, ClientTop, ClientHeight, and ClientWidth. Use the MultiRow property to specify whether the control can have more than one row of tabs. Use the TabWidthStyle property to specify the appearance of each row, and if TabWidthStyle is set to tabFixed, use the TabFixedHeight and TabFixedWidth properties to set the same height and width for all the tabs in the TabStrip control.

The TabStrip Control Isn't a Container

Although the TabStrip control might appear to be a container of sorts, it isn't. To see how this works, place a TabStrip control on a user form. Add a CommandButton control to the tab strip, and then move the tab strip to a different location on the form. You'll see that the command button doesn't remain on the TabStrip; instead, it's left sitting on the form.

To contain the actual pages and their objects, you must use Frame controls or other containers that match the size of the internal area, which is shared by all the Tab objects in the control. The best strategy is to create a separate container for each Tab object, and then use code that will position, show, and hide the containers when the user clicks particular Tab objects. If you use this method, your user form at design time will probably look something like the following illustration.
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Positioning the Container Control

You can use the TabStrip control's various Clientxxx properties to position the container controls (Frame controls, in this case), as in the following code:

Private Sub UserForm_Initialize()

    ' Match the first frame's position to the user form.

    frmOne.Left = tbsODE.ClientLeft

    frmOne.Top = tbsODE.ClientTop

    frmOne.Width = tbsODE.ClientWidth

    frmOne.Height = tbsODE.ClientHeight

    ' Match the second frame's position to the user form.

    frmTwo.Left = tbsODE.ClientLeft

    frmTwo.Top = tbsODE.ClientTop

    frmTwo.Width = tbsODE.ClientWidth

    frmTwo.Height = tbsODE.ClientHeight

    ' Start with frame one visible, frame two hidden.

    frmOne.Visible = True

    frmTwo.Visible = False

End Sub

Showing and Hiding the Container Control

You can use the TabStrip control's SelectedItem property and Click event to associate each container with a specific Tab object, as in the following example:

Private Sub tbsODE_Click()

    ' Select case based on which tab is clicked.

    Select Case tbsODE.SelectedItem.Index

        Case 1

            ' Make frame one visible, hide frame two.

            frmOne.Visible = True

            frmTwo.Visible = False

        Case 2

            ' Make frame two visible, hide frame one.

            frmOne.Visible = False

            frmTwo.Visible = True

    End Select

End Sub

Note   When grouping controls in a container, you must use the preceding show/hide technique instead of the ZOrder method to bring a frame to the front. Otherwise, controls that that are triggered by access keys (ALT+access key) will still respond to keyboard commands, even if the container isn't the topmost control. Also note that you must segregate groups of OptionButton controls by placing each group in its own container; otherwise, all OptionButton controls on the form will behave collectively as one large group of controls.

Alternatives to the ODE TabStrip Control

Two alternatives you might want to consider are the Microsoft Forms 2.0 TabStrip control and the MultiPage control. Both of these controls are included in Office, so it's not necessary to install ComCtl32.ocx.

The Microsoft Forms 2.0 TabStrip control

This control is very similar to the ComCtl32.ocx version of TabStrip. In fact, you could substitute the Forms 2.0 version in the following procedure with only minor changes to the code (insert a parameter in the control's Click event, and change the index values in the event code from 1 and 2 to 0 and 1). In comparing the properties, methods, and events supported by the two versions of this control, you'll notice some differences. The major difference is that the various OLE events aren't supported by the Forms 2.0 TabStrip control.

The MultiPage control

In most cases where you could use a TabStrip control, you might want to use the MultiPage control instead. With the MultiPage control, each page is a separate container, so you don't need to create and manage your own containers, as discussed earlier and illustrated in the following procedure. To see how this works, add a MultiPage control to a user form, and add a CommandButton control to one of the pages, and then drag the MultiPage control. Notice that the command button moves with its page; and if you click a tab on the MultiPage control, you'll see that the command button is covered by the page that's displayed.

Using the TabStrip Control

This section provides a simple example of using the TabStrip control in Microsoft Excel.

Add a tab strip to a user form 

1. In Excel, open the Visual Basic Editor, and then perform steps 1 and 2 of the procedure "Add a StatusBar control to a user form" earlier in this article.

2. In the Available Controls box, select Microsoft TabStrip control, version 5.0, and then click OK.

3. Add a TabStrip control to the user form.

4. Click the TabStrip control, and then open the Properties window.

5. In the Properties window, click (Custom), and then click the Properties button (…).

6. In the Properties dialog box, click Tabs.

7. In the Caption box, type Tasks.

8. Click Insert Tab, type Comments in the Caption box, and then click OK. 

Add additional controls to the form 

1. Drag a Frame control from the Toolbox onto the user form.

2. Insert a TextBox control and two CommandButton controls into the frame on the form.

3. Click the frame, and then use the Copy and Paste commands on the Edit menu to add a second Frame control containing the same set of controls.

4. Position the controls so that your form resembles the illustration under "The TabStrip Control Isn't a Container" earlier in this article.

5. Set Caption, Name, and Text properties for your controls, using the settings listed in the following table. 

	Object
	Property
	Setting

	User form
	Caption
	TabStrip

	Tab strip
	Name
	tbsODE

	First frame
	Name
	frmOne

	First frame
	Caption
	Tasks

	First text box
	Name
	txtTasks

	First text box
	Text
	Empty

	First command button
	Name
	cmdTaskOK

	First command button
	Caption
	OK

	Second command button
	Name
	cmdTaskCancel

	Second command button
	Caption
	Cancel

	Second frame
	Name
	frmTwo

	Second frame
	Caption
	Comments

	Second text box
	Name
	txtComments

	Second text box
	Text
	Empty

	Third command button
	Name
	cmdComOK

	Third command button
	Caption
	OK

	Fourth command button
	Name
	cmdComCancel

	Fourth command button
	Caption
	Cancel


6. In the Code window, enter the following procedures: 

7. Private Sub cmdComCancel_Click()

8.     ' Clear the text box.

9.     txtComments.Text = ""

10. End Sub

11. Private Sub cmdComOK_Click()

12.     ' Add text to the current cell.

13.     Application.ActiveCell = "COMMENT: " & txtComments.Text

14.     ' Move down one row.

15.     ActiveCell.Offset(1, 0).Range("a1").Select

16.     ' Clear the text box.

17.     txtComments.Text = ""

18. End Sub

19. Private Sub cmdTskCancel_Click()

20.     ' Clear the text box.

21.     txtTasks.Text = ""

22. End Sub

23. Private Sub cmdTskOK_Click()

24.     ' Add text to the current cell.

25.     Application.ActiveCell = "TASK: " & txtTasks.Text

26.     ' Move down one row.

27.     ActiveCell.Offset(1, 0).Range("a1").Select

28.     ' Clear the text box.

29.     txtTasks.Text = ""

30. End Sub

31. Private Sub tbsODE_Click()

32.     ' Select case based on which tab is clicked.

33.     Select Case tbsODE.SelectedItem.Index

34.         Case 1

35.             ' Make frame one visible, hide frame two.

36.             frmOne.Visible = True

37.             frmTwo.Visible = False

38.         Case 2

39.             ' Make frame two visible, hide frame one.

40.             frmOne.Visible = False

41.             frmTwo.Visible = True

42.     End Select

43. End Sub

44. Private Sub UserForm_Initialize()

45.     ' Match the frame's position to the user form.

46.     frmOne.Left = tbsODE.ClientLeft

47.     frmOne.Top = tbsODE.ClientTop

48.     frmOne.Width = tbsODE.ClientWidth

49.     frmOne.Height = tbsODE.ClientHeight

50.     frmTwo.Left = tbsODE.ClientLeft

51.     frmTwo.Top = tbsODE.ClientTop

52.     frmTwo.Width = tbsODE.ClientWidth

53.     frmTwo.Height = tbsODE.ClientHeight

54.     ' Start with frame one visible, frame two hidden.

55.     frmOne.Visible = True

56.     frmTwo.Visible = False

End Sub
7. Click Run Sub/UserForm or press F5.

8. Adjust the size and positioning of the worksheet and the user form so that you can see both simultaneously. Then click the tabs in turn, making entries in the text controls. 
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Toolbar Control

The Toolbar control contains the Button collection, whose Button objects you can use to create a toolbar that's associated with a particular Office application.

Typically, a toolbar contains buttons that correspond to commands on an application's menus, providing a graphic interface with which the user can quickly access the application's most frequently used features and capabilities.

Using the Toolbar control, you object can contain optional text or an image, or both, which you insert from an associated ImageList control. On each button, you can display an image by using the Image property or display text by using the Caption property, or both. At design time, you can add buttons to the toolbar by selecting the Toolbar control and then using options on the Properties page. At run time, you can add and remove Button objects from the Buttons collection by using the Add and Remove methods.

To program a toolbar button to trigger a specific action, add the appropriate code to its ButtonClick event. You can also determine the behavior and appearance of each Button object by using the Style property. For example, if you've assigned the ButtonGroup style to four different buttons, only one button can be pressed at any given time, and at least one button is always pressed.

You can create space for other controls on a toolbar by assigning the PlaceHolder style to a button and then positioning a control over the placeholder. For example, to add a drop-down combo box to a toolbar at design time, do the following: add a Button object, assign the PlaceHolder style to it, adjust its size until it's the same width as a ComboBox control, and then drag a ComboBox control onto the placeholder.

Double-clicking a Toolbar object at run time opens the Customize Toolbar dialog box, in which the user can set options to hide, display, or rearrange toolbar buttons. To enable or disable this dialog box, use the AllowCustomize property. You can also use the Customize method to open this dialog box.

To save a toolbar in its current state and then restore it to this state at a later time, or to enable the user to do so, use the SaveToolbar and RestoreToolbar methods. The Change event, which is triggered when a Toolbar object is altered, is what you typically use to invoke the SaveToolbar method.

Possible Uses

If you're working within an Office application, as opposed to using Office objects in another container, use the CommandBars portion of the Microsoft Office object model to work with menus and to create and modify toolbars. Whereas you can use the ToolBar control to create generic toolbars for any Windows-based application, the CommandBar control is specifically designed for manipulating and extending the user interface within Office applications.

That said, the ToolBar control makes it possible for you to: 

· Place often-used operations, such as those on an Office application's File menu, in one easy-to-access place.

· Provide a graphical, intuitive user interface for your application.

· Provide a consistent user interface among applications with matching toolbars. 

Note   The Customize dialog box also includes a Help button. Use the HelpFile and HelpContextID properties to determine which (if any) Help file is displayed when the end user clicks the Help button.

You can further enhance usability by adding a ToolTip description for each of your Button objects. If you want ToolTips to be displayed, you must have the ShowTips property set to True. That way, when the user opens the Customize Toolbar dialog box and clicks a toolbar button in it, a description of that button will pop up on-screen. You create this description by selecting the button and then typing whatever text you want in the Description field in the Properties window.

Using the ToolBar Control

This section provides two procedures that demonstrate how you can use the Toolbar control in an Office application.

Add controls and set basic properties 

1. In an Office application, open the Visual Basic Editor, and then perform steps 1 and 2 of the procedure "Add a StatusBar control to a user form" earlier in this article.

2. In the Available Controls box, select Microsoft Toolbar Control, version 5.0 and Microsoft ImageList Control, version 5.0, and then click OK.

3. Add a Toolbar control, an ImageList control, and a TextBox control to the user form.

4. In the Properties window, set Name and Caption properties for your controls, using the settings listed in the following table. 

	Object
	Property
	Setting

	User form
	Name
	usfContainer

	User form
	Caption
	ToolBar

	ImageList control
	Name
	imgTlbExample

	Toolbar
	Name
	tlbODE

	Text box
	Name
	txtDisplay


Set more properties for the ImageList and Toolbar controls 

1. Click the Toolbar control on the user form.

2. In the Properties window, click (Custom), and then click the Properties button (…).

3. In the Properties dialog box, click the Buttons tab.

4. In the Caption box, type Red.

5. In the Key box, type a.

6. Click Insert to add a new button.

7. Repeat steps 4, 5, and 6 to add two more buttons, and set their Key property to b and c and their Caption property to Green and Blue, respectively.

8. Add three images to the ImageList control, and set their Key property to a, b, and c, respectively. For information on how to do this, see "Using the Image List Control" in the article "ActiveX Controls in the Office 97 Developer Edition (Part 1)" at the following Web address: http://www.microsoft.comhttp://msdn.microsoft.com/officedev/o-a&sa.htm. 

Add code and then run it 

1. Click the ImageList control on the user form.

2. In the Code window, enter the following procedures: 

3. Private Sub tlbODE_ButtonClick(ByVal Button As ComctlLib.Button)

4.     Select Case Button.Key

5.         ' Selects based on which button is clicked.

6.         Case "a"

7.             txtDisplay.ForeColor = vbRed

8.         Case "b"

9.             txtDisplay.ForeColor = vbGreen

10.         Case "c"

11.             txtDisplay.ForeColor = vbBlue

12.     End Select

13. End Sub

14. Private Sub UserForm_Initialize()

15.     Dim btnODE As Button

16.     ' Bind the image list and tool bar controls.

17.     usfContainer.tlbODE.ImageList = imgTlbExample

18.     ' Bind the buttons to the images.

19.     usfContainer.tlbODE.Buttons(1).Image = 1

20.     usfContainer.tlbODE.Buttons(2).Image = 2

21.     usfContainer.tlbODE.Buttons(3).Image = 3

End Sub
3. Click Run Sub/UserForm or press F5.

4. Type some text in your text box, and then see what happens when you click the toolbar buttons on the form. 
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TreeView Control

The TreeView control displays a hierarchical list of Node objects, each of which consists of a label and an optional bitmap. The TreeView control is designed to display data that's hierarchical in nature, such as organization trees, the entries in an index, or the files and folders on your hard disk.

After creating a TreeView control, you can add, remove, arrange, and otherwise manipulate Node objects by setting properties and invoking methods. You can programmatically expand and collapse Node objects to display or hide all "child" nodes. The Collapse, Expand, and NodeClick events also provide programming functionality.

You can move through a tree in code by retrieving a reference to Node objects, using the Root, Parent, Child, FirstSibling, Next, Previous, and LastSibling properties. Users can move through a tree by using the keyboard as well, as described in the following paragraphs: 

· The UP ARROW and DOWN ARROW keys cycle downward through all expanded Node objects. Node objects are selected from left to right, and from top to bottom. When the user reaches the bottom of a tree by using the DOWN ARROW, the selection jumps back to the top of the tree, scrolling through the window if necessary.

· The RIGHT ARROW and LEFT ARROW keys also tab through expanded Node objects, but if the user presses the RIGHT ARROW key while an unexpanded node is selected, the node expands; a second press of RIGHT ARROW moves the selection to the next node. Conversely, pressing the LEFT ARROW key while an expanded node has the focus collapses the node.

· If the user presses an ANSI key, the focus jumps to the nearest node that begins with that letter. Subsequent pressings of that key cause the selection to cycle downward through all expanded nodes that begin with that letter. 

There are several styles you can use to alter the appearance of the control. Node objects can appear in any one of eight combinations of text, bitmaps, lines, and plus/minus signs. 

The TreeView control uses the ImageList control specified by the ImageList property to store the bitmaps and icons that are displayed in Node objects. A TreeView control can use only one ImageList control at a time. This means that if the TreeView control's Style property is set to a style that displays images, every item in the TreeView control will have an image exactly same size next to it.

Using the TreeView Control

This section provides a procedure that shows you how to use the TreeView control in an Office application. You'll use the Northwind sample database in this procedure.

Create and program a TreeView control 

1. Open the Visual Basic Editor, and then perform steps 1 and 2 of the procedure "Add a StatusBar control to a user form" earlier in this article.

2. In the Available Controls box, select Microsoft TreeView control, version 5.0, and then click OK.

3. Because you'll be using the Northwind sample database in this procedure, you'll need a reference to DAO 3.5. In the Visual Basic Editor, click References on the Tools menu. In the References dialog box, select Microsoft DAO 3.5 Object Library, and then click OK.

4. Add a TreeView control to the user form.

5. Set the user form's Caption property to TreeView.

6. Set the TreeView control's Name property to tvwODE.

7. In the Code window, enter the following declarations and procedure: 

8. Option Explicit

9. Public mdbNWind As Database

10. Public nodODE As Node

11. Public rsProducts As Recordset

12. Private Sub UserForm_Initialize()

13.     ' Open the Northwind db.

14.     Set mdbNWind = DBEngine.OpenDatabase("c:\program files\devstudio\vb\nwind.mdb")

15.     ' Add a Node object.

16.     Set nodODE = tvwODE.Nodes.Add(, , "r", "Products")

17.     ' Open a recordset containing a single field from the Products table.

18.     Set rsProducts = _

19.     mdbNWind.OpenRecordset _

20.     ("SELECT Products.ProductName FROM Products;")

21.     Dim intCounter As Integer

22.     ' Add nodes displaying product names for four products

23.     For intCounter = 1 To 4

24.         ' Add the Node object.

25.         Set nodODE = tvwODE.Nodes.Add(1, tvwChild)

26.         ' Set the node Text property.

27.         nodODE.Text = rsProducts!PRODUCTNAME

28.         ' Move to the next record.

29.         rsProducts.MoveNext

30.     Next intCounter

End Sub
8. Click Run Sub/UserForm or press F5.

9. On the TreeView control, double-click Products to display the nodes that contain product names. 

UpDown Control

The UpDown control has a pair of arrow buttons that the user can click to increment or decrement a value, such as a scroll position or a value in an associated control, or buddy control.

To the user, an UpDown control and its buddy control often look like a single control. The buddy control can be any control that you can link to the UpDown control by using the BuddyControl property. Buddy controls usually display data, such as text boxes or command buttons.

Note   You cannot use such windowless controls as the built-in Label control as buddy controls.

The Microsoft Forms 2.0 object library contains a SpinButton control with similar functionality. Because the UpDown control comes with more properties, events, and methods than does the SpinButton control, it's much more useful for getting exactly the behavior you want in your application. For example, the Object Browser lists 24 properties and 16 events for the UpDown control, and only 11 properties and 9 events for the SpinButton control. SpinButton doesn't provide any of the OLE events provided by UpDown. The AutoBuddy, BuddyControl, Alignment, Increment, and Wrap properties (discussed in the following section) are available with UpDown but not with SpinButton.

Using the AutoBuddy, BuddyControl, and Alignment properties

By setting the AutoBuddy property, you can have the UpDown control automatically use the previous control in the tab order as its buddy control. If there's no previous control in the tab order, the UpDown control will use the next control in the tab order as its buddy control. Another way to set the buddy control is by using the BuddyControl property. At design time, when you're setting either the AutoBuddy property or the BuddyControl property, the buddy control will automatically pair up with the UpDown control by sizing and positioning itself next to UpDown. You can use the Alignment property to position UpDown either to the right or to the left of its buddy control.

Note   To set the BuddyControl property for an UpDown control on a user form at design time, try setting the SyncBuddy property in the Properties window first. If you get an error when you attempt to set SyncBuddy, click OK in the error message; you can then set the BuddyControl property. Otherwise, if you try to set BuddyControl at run time, you might trigger the following error message: "BuddyControl must be a separate control within the same container."

Using the Increment, Min, Max, and Wrap properties

Use the Increment, Min, Max, and Wrap properties to specify how you want the UpDown control's Value property to change when the user clicks the buttons on the control. For example, if you have values that are multiples of 10, ranging from 20 to 80, you can set the Increment, Min, and Max properties to 10, 20, and 80, respectively. The Wrap property enables the Value property to increment beyond the value of the Max property and then start again at the Min property, or vice versa.

An UpDown control without a buddy control functions as a sort of simplified scroll bar.

Install the UpDown control
The UpDown control is provided in the file Comct232.ocx in the ODE. If the UpDown control isn't listed in the Additional Controls dialog box, you may need to add a reference to this file. 

1. Copy the file Comct232.ocx from the ODETools folder on the ODE compact disc to your System folder or System32 folder.

2. In the Visual Basic Editor, click UserForm on the Insert menu.

3. On the Tools menu, click References.

4. In the References dialog box, click Browse. 

5. In the Add Reference dialog box, click Mswinsck.ocx in the list of files, and then click Open. 

Using the UpDown Control

This section provides a procedure that shows you how to use the UpDown control in an Office application. 

Create and program an UpDown control 

1. Open the Visual Basic Editor, and then perform steps 1 and 2 of the procedure "Add a StatusBar control to a user form" earlier in this article.

2. In the Available Controls box, select Microsoft UpDown control, version 5.0, and then click OK. If it is not listed, see the section "Install the UpDown control" above.

3. Add an UpDown control and two TextBox controls to the user form.

4. In the Properties window, set properties for the user form and the controls you've added to it, using the settings listed in the following table. 

	Object
	Property
	Setting

	User form
	Caption
	Updown

	User form
	Name
	usfContainer

	UpDown control
	Name
	updODE

	UpDown control
	BuddyControl
	txtBuddy

	First text box
	Name
	txtBuddy

	First text box
	Text
	blank

	Second text box
	Name
	txtTarget

	Second text box
	Text
	blank


5. Adjust the size and positioning of the controls on the form so that your form resembles the one shown in the following illustration. 

[image: image13]
6. In the Code window, enter the following statement and procedure: 

7. Option Explicit

8. Private Sub updODE_Change()

9.     ' Use the Value property to set font size.

10.     usfContainer.txtTarget.Font.Size = updODE.Value

11.     ' Display the current "font size. "

12.     usfContainer.txtBuddy.Text = updODE.Value

13. End Sub

14. Private Sub UserForm_Initialize()

15.     ' Set various UpDown control property values.

16.     With updODE

17.         .Min = 6

18.         .Max = 24

19.         .Increment = 1

20.         .Wrap = True

21.     End With

22.     ' Text for display.

23.     txtTarget.Text = "Font.Size set by UpDown control"

End Sub
7. Click the UpDown control. 

You'll notice that because your application can display the font in the text box in only a limited range of point sizes, the text isn't automatically resized every time the UpDown control is clicked.
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Winsock Control

The Winsock control, which is invisible to the user, provides easy access to the Transfer Control Protocol (TCP) and the User Datagram Protocol (UDP) network services. You can use it on user forms in Microsoft Excel, Word, and PowerPoint®; on built-in forms in Microsoft Access; and in Visual Basic, Visual C++®, or Visual FoxPro®. To write client/server applications, you don't need to understand the details of TCP or how to call low-level Winsock application programming interfaces (APIs). By setting properties and invoking methods of the Winsock control, you can easily connect to a remote computer and exchange data in both directions.

Possible Uses

· Create a client application that collects user information before sending it to a central server.

· Create a server application that functions as a central collection point for data from multiple users.

· Create a "chat" application. 

Selecting a Protocol

When using the Winsock control, you first need to decide whether to use TCP or UDP. The primary difference between the protocols two lies in their connectivity status: 

· TCP is a connection-based protocol; it's analogous to a telephone, in that the user must establish a connection before proceeding.

· UDP is a connectionless protocol in which the interaction between two computers is like the passing of a note back and forth; a message is sent from one computer to the other, but there's no explicit connection between the two. Another difference is that with UDP, the maximum size of individual data transmissions is determined by the network. 

The nature of the application you're creating will generally determine which protocol you select. Here are a few questions that may help you select the appropriate protocol: 

· Will the application require acknowledgment from the server or client when data is sent or received? If so, TCP requires an explicit connection before sending or receiving data.

· Will the volume of data be extremely large (such as with image or sound files)? After a connection has been made, TCP maintains the connection and ensures the integrity of the data. This connection, however, uses up more of your computers' operating capacity, making it more "expensive."

· Will the data be sent intermittently or all in one session? For example, if you're creating an application that will notify specific computers when certain tasks have been completed, UDP may be more appropriate. This protocol is also better suited to sending small amounts of data. 

TCP Basics

Using TCP, you can create and maintain a connection to a remote computer. After this connection has been made, you can "stream" data between the two computers.

If you're creating a client application, you must know the server computer's name or Internet Protocol (IP) address (RemoteHost property), as well as the port (RemotePort property) on which the server will be "listening." After determining the IP address and the port, use the Connect method.

If you're creating a server application, set a port (LocalPort property) on which to listen, and then use the Listen method. When the client computer requests a connection, the ConnectionRequest event will occur. To complete the connection, use the Accept method in the ConnectionRequest event.

After a connection has been made, you can transmit data to or from either computer. To send data, use the SendData method. Whenever data is received, the DataArrival event occurs. Use the GetData method in the DataArrival event to retrieve the data.

UDP Basics

UDP is a connectionless protocol. Unlike computers running TCP operations, computers using UDP don't establish a connection. Also, a UDP application can be either a client or a server.

To transmit data, first set the client computer's LocalPort property. Then set the RemoteHost property for the server computer to the Internet address of the client computer, and set the RemotePort property to the same port as the client computer's LocalPort property. Finally, use the SendData method to begin sending messages. The client computer uses the GetData method in the DataArrival event to retrieve sent messages.

Setting the Protocol

To set the protocol that your application will use, click Protocol in the Properties window at design time and then click either sckTCPProtocol or sckUDPProtocol. You can also set the Protocol property programmatically by using the following code:

Winsock1.Protocol = sckTCPProtocol

Determining the Name of Your Computer

To connect to a remote computer, you must know either its IP address or its "friendly name." The IP address is a series of three-digit numbers separated by periods (xxx.xxx.xxx.xxx). In general, it's much easier to remember the friendly name of a computer.

To find your computer's name 

1. On the Windows taskbar, click Start.

2. Point to Settings, and then click Control Panel.

3. Double-click the Network icon.

4. Click the Identification tab. 

The name of your computer is displayed in the Computer name box.

After you've determined your computer's name, you can use it as a value for the RemoteHost property.

Creating an Application That Uses the TCP Protocol 

When creating an application that uses TCP, you must first decide whether your application will be a client or a server. The client makes a connection request, which the server can then accept to complete the connection. After the connection has been made, the client and server can freely communicate with one another.

Installing the Winsock Control

To run the two procedures in the "Using the Winsock Control" section, you'll need to have the Winsock control installed on both your client and server machines. If either of these machines doesn't have Winsock installed, perform the following steps:

Install Winsock on both of your machines 

1. Copy the file Mswinsck.ocx from the ODE compact disc to your System folder or System32 folder.

2. In the Visual Basic Editor, click UserForm on the Insert menu.

3. On the Tools menu, click References.

4. In the References dialog box, click Browse.

5. In the Add Reference dialog box, click Mswinsck.ocx in the list of files, and then click Open. 

Using the Winsock Control

This section provides two procedures that show you how to use the Winsock control create a TCP client and a TCP server. In these procedures, you'll create separate client and server applications and then run them on separate machines.

Create a TCP server application 

1. In an Office application, open the Visual Basic Editor, and then perform steps 1 and 2 of the procedure "Add a StatusBar control to a user form" earlier in this article.

2. In the Available Controls box, select Microsoft Winsock Control, version 5.0, and then click OK. If the Winsock control isn't listed here, you'll need to add a reference to the file Mswinsck.ocx. For information on how to do this, see the procedure "Install Winsock on both of your machines" in the preceding section.

3. Add a Winsock control to the user form.

4. In the Properties window, set Name and Caption properties for your TCP server application, using the settings listed in the following table. 

	Object
	Property
	Setting

	User form
	Name
	usfServer

	User form
	Caption
	TCP Server

	Winsock
	Name
	tcpServer

	First text box
	Name
	txtSendData

	Second text box
	Name
	txtOutput


5. In the Code window, enter the following procedures: 

6. Option Explicit

7. Private Sub tcpServer_ConnectionRequest(ByVal requestID As Long)

8.     ' Check if the value of the control's State property

9.     ' is closed. If not, close the connection before

10.     ' accepting the new connection.

11.     If tcpServer.State <> sckClosed Then tcpServer.Close

12.     ' Accept the request with the requestID parameter.

13.     tcpServer.Accept requestID
14. End Sub

15. Private Sub txtSendData_Change()

16.     ' The TextBox control named txtSendData

17.     ' contains the data to be sent. Whenever the user

18.     ' types into the textbox, the string is sent

19.     ' using the SendData method.

20.     tcpServer.SendData txtSendData.Text

21. End Sub

22. Private Sub tcpServer_DataArrival(ByVal bytesTotal As Long)

23.     ' Declare a variable for the incoming data.

24.     ' Use the GetData method and set the Text

25.     ' property of a TextBox named txtOutput to

26.     ' the data.

27.     Dim strData As String

28.     tcpServer.GetData strData

29.     ' In Microsoft Access, substitute txtOutput.Value

30.     ' for txtOutput.Text in the following line.

31.     txtOutput.Text = strData

32. End Sub

33. Private Sub UserForm_Initialize()

34.     ' Set the LocalPort property to an integer.

35.     ' Then invoke the Listen method.

36.     tcpServer.LocalPort = 1001

37.     tcpServer.Listen

End Sub
Create a TCP client application 
1. In the Visual Basic Editor, insert a user form.

2. Add a Winsock control, a CommandButton control, and two TextBox controls to the form.

3. In the Properties window, set Name and Caption properties for your TCP client application, using the settings listed in the following table. 

	Object
	Property
	Setting

	User form
	Name
	usfClient

	User form
	Caption
	TCP Client

	Winsock
	Name
	tcpClient

	Command button
	Name
	cmdConnect

	Command button
	Caption
	Connect

	First text box
	Name
	txtSendData

	Second text box
	Name
	txtOutput


4. Click the user form.

5. Make sure that the value of the RemoteHost property is set to the name of your server machine.

6. In the Code window, enter the following procedures: 

7. Option Explicit

8. Private Sub UserForm_Initialize()

9.     ' The name of the Winsock control is tcpClient.

10.     ' Note: To specify a remote host, you can use

11.     ' either the IP address (ex: "121.111.1.1") or

12.     ' the computer's friendly name, as shown here.

13.     tcpClient.RemoteHost = "your server machine"

14.     tcpClient.RemotePort = 1001

15. End Sub

16. Private Sub cmdConnect_Click()  ' Invoke the Connect method to initiate a

17.     ' connection.

18.     tcpClient.Connect

19. End Sub

20. Private Sub txtSendData_Change()

21.     tcpClient.SendData txtSendData.Text

22. End Sub

23. Private Sub tcpClient_DataArrival(ByVal bytesTotal As Long)

24.     Dim strData As String

25.     tcpClient.GetData strData

26.     txtOutput.Text = strData

End Sub
Running the Winsock Client/Server Application

The code you ran in the preceding exercise creates a simple client/server application. To try the two components together, copy either the client or server application to another computer. Open the client on one computer, open the server on the other one, and then click Connect on the client form. When you type text in the txtSendData box on either form, the same text should appear in the txtOutput box on the other form.
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The Server application
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The Client application
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